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Apple Pro Training Series: Pages, Numbers, and Keynote

In the only Apple-certified book on the Apple productivity 
apps—Pages, Numbers, and Keynote, you’ll learn the how 
and why of creating and publishing first-rate documents, 
spreadsheets, and presentations. Working through this guide, 
you will gain confidence working on progressively more 
complex, real-world projects, using Pages, Numbers, and 
Keynote both alone and together to produce sophisticated 
and robust results. This guide provides coverage of the latest 
features in the Apple productivity apps.

	 All new guide covers the Pages, Numbers, and Keynote 
productivity apps for Mac; explores iOS versions of the apps; 
and shows workflows using iCloud Drive.

	 Quick tour through all three apps on OS X highlights the 
similarities in their interfaces and tools and reveals important 
new features.

	 Self-paced course-in-a-book with accompanying lesson files 
focuses on practical, real-world projects building in complexity 
throughout the guide.

	 The official curriculum of Apple Training Pages, Number,  
and Keynote course used in Apple Authorized Training  
centers worldwide.

	 Chapter review questions summarize what students learn  
to prepare them for the Apple certification exam.

The Apple-Certified Way to Learn

The Apple Pro Training Series is both a self-paced 
learning tool and the official curriculum of the Apple Training  
and Certification program. Upon completing the course material 
in this guide, you can become Apple Certified by passing the 
certification exam at an Apple Authorized Training Center. To  
find an Apple Authorized Training Center near you, please visit 
training.apple.com.

Also in the Apple Pro Training Series:
	 iPhoto
	 iMovie
	 GarageBand
	 Final Cut Pro X 
	 Logic Pro X

About the Author

Mark Wood is an Apple Certified Trainer, graphic designer, and 
photographer with over 20 years experience as a creative 
professional and educator. Mark has developed professional 
training classes and taught both undergraduate and postgraduate 
courses. He has also been a Mentor Trainer and delivered train-
the-trainer courses for the Apple Authorized Training Program. 
This is Mark’s first book in the Apple Pro Training Series.

Level: Beginner/Intermediate
Category: Productivity apps
Requires: Pages 5.5.1, Numbers 3.5, Keynote 6.5,  
OS X 10.10 or later, some content may require an iOS 
device with iOS 8.1 or later and Internet access

Peachpit Press
www.peachpit.com

Companion Web Page: 
www.peachpit.com/apts.pnk

Pages: Design reports, brochures, and promotional 
material and share your work on multiple devices.

Numbers: Prepare real-world solutions using 
tables and charts to analyze and track data.

Keynote: Create compelling presentations 
using animation and video to communicate  
ideas with style.
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Let Reason shine.
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4
	 Lesson Files	 APTS Pages Numbers Keynote > Lesson_04 > 2009_report.pages

	 Time	 This lesson takes approximately 60 minutes to complete.

	 Goals	 Use tables to calculate and compare values

		  Add charts to present data

		  Create bulleted and numbered lists

		  Review a document

		  Add footnotes and endnotes
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Pages, like Numbers and Keynote, can handle data intelligently: Tables 

can be used to run calculations, and charts can display and readily update 

statistical information. What you learn about tables and charts in this les-

son can be applied to Numbers and Keynote, though Numbers does have 

some extra table formatting control not found in Pages or Keynote.

In this lesson, you’ll also look at how you can review a document to 

check spelling and grammar, and look up word definitions.

You’ll work with a single document that was created using the version 

of Pages found in iWork ’09—updating that document before adding a 

list, table, or chart.

Working with Charts  
and Data

Lesson 4
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Opening a Pages ’09 Document

The current version of Pages maintains backward compatibility with the previous release, 
Pages ’09. When opening a Pages ’09 document, you have two options for converting the 
document to the latest version of Pages.

1	 In the Finder, locate the APTS Pages Numbers Keynote > Lesson_04 folder.

2	 Double-click 2009_report.pages to open it in Pages without any warnings that it was 
created in Pages ’09.

3	 Choose File > Save, and click Upgrade.

Alternatively, to preserve the original Pages ’09 document, click Edit a Copy. Pages 
will duplicate the original document and upgrade it before opening it in Pages.

NOTE ▶ ​To open a Pages ’08 document, you must first open it in Pages ’09.

Using a Table to Add Data

Tables are a great way to organize information, such as work schedules or action plans. 
In Pages, Numbers, and Keynote, tables automatically detect the format of the data being 
added. In this exercise, you’ll investigate the power of automatic data detection.
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1	 Go to page 5 of 2009_report.pages, titled “budget.”

2	 Click at the end of the line that ends with the word “restoration,” and press Return.

3	 In the toolbar, click the Table icon. In the dialog that opens, click the table in the 
lower left.

A simple table is added to the page. Now you’ll format it.

4	 Click row header 1 to open a pop-up menu. Choose Add Header Row Above.
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5	 Click cell B1, type Phase Number, and press Tab to move to cell C1. In cell C1, type 
Description, and press Tab again to move to the next cell; and in cell D1, type Budget.

6	 In the row reference column, click the symbol beneath the number 6 to open a control.

7	 Click the arrows to change the number of rows to 14.

NOTE ▶ ​Alternatively, you can double-click the number 6, type 14, and then press 
Return.

8	 Click cell A2, and type January.
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9	 Move the pointer over the lower border of cell A2. A yellow handle appears, intersect-
ing the cell border.

10	 Drag the yellow handle down to row 13. All the months of the year appear.

11	 Click cell B2, and type Phase 1. Move your pointer so that the yellow handle  
intersecting the cell border appears.

12	 Drag the yellow handle down to row 13. A sequence is created from Phase 1 to Phase 12.

The table automatically detects the numeral 1 after the text component in the cell, 
which causes the auto-sequence.

NOTE ▶ ​If you typed 1 Phase, placing the number before the text, the auto-sequence 
is not created.
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13	 Click cell C2. Type Blurb. Repeat the steps described previously to drag the contents 
of cell C2 down to cell C13.

This time the only the word “Blurb” was repeated. No special data format was 
detected because the cell contains only text.

14	 Click cell D2, and type $7000. Drag the yellow handle to repeat $7000 in  
column D down to row 13.

By typing the dollar sign, you are setting the data format to currency.

15	 Click cell D2, and type 5000. Click cell D4, and type 12000.

You now need to let Pages know that the values 5000 and 12000 are also meant to be 
dollar amounts.

16	 Click cell D2, and Shift-click cell D13 to select all the number values in column D.

17	 In the Cell inspector, change the data format to Currency. Select the Thousands  
Separator checkbox, and set the Decimals value to 2.

The values in column D are set to dollars with two decimal points.

 In the Currency menu, you can choose a different currency.
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NOTE ▶ ​Tables in Pages, Numbers, and Keynote are set to detect data automatically; 
but to manually format cells, select them and in the Cell inspector choose another 
data format.

Formatting Tables

You’re currently working with a simple table containing a variety of data formats. You will 
now create a formula to add up the budget figures in column D.

1	 Click the cell reference bar for row 14, and from the pop-up menu, choose Convert  
to Footer Row.

Footer rows are often used to total columns in accountancy style spreadsheets. You’ll 
now add a totalizer in the footer row.

2	 Double-click cell D14. Press the = (equals) key. The Formula Editor appears.
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3	 Click cell D2

The cell is now highlighted with two handles in opposite corners.

4	 Click the handle in the lower right of the cell, and drag it down to cell D13 to quickly 
place all the figures into a formula. Click the checkmark to run the calculation.

 Another way to set this calculation would be to double-click cell D14, type 
the formula =sum(d2:d13), and then press Return.

5	 Click the table handle icon at the top left of the table.

How and where you click a table affects which edits you can perform.

6	 In the Layout tab of the Text inspector, change the Text Inset to 6 pt.
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7	 In the Table inspector, locate Row & Column Size. Click the Fit button for Column.

The table shrinks to fit the cell contents. Graphically the table is too narrow, so let’s 
stretch it out a little.

Where you click a table affects the available editing options. If a table is first selected 
by carefully clicking its outside edge, selection handles appear. Doing this can be 
tricky. If a cell is selected, the table selection handles won’t be available. To make 
selection handles appear, click the table handle icon.

8	 With the table selection handles active, drag the side of the table to the right. The 
whole table stretches, giving the cell contents more space.

Don’t drag the table edge too close to the edge of the document page because you’ll 
need some extra space later.

The Description column could be wider still.
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9	 Move your pointer to the division between the header references for columns C  
and D. Drag the dividing line to the right to make column C wider.

You can also set precise measurements for column width and row height.

10	 Click the reference bar for column C. In the Table inspector, in the Column data field, 
type 2 in. Doing this adds clarity to the table layout.

Creating List Structures

Tables are ideal when you need to sort data and run calculations; but when you simply 
need to create a hierarchy of ideas, tiered numbered lists are a great solution. On pages 3 
and 4 of the 2009_report document you’ll find an outline plan. Let’s format it using tiered 
numbers.

1	 Select the text on page 3, starting with the paragraph beginning, “The mounting,” 
through to the paragraph on page 4 beginning, “Mud ring.”
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2	 In the Text inspector, locate Bullets & Lists. Set the bullet type to Numbers, use stan-
dard Arabic numerals, and select Tiered Numbers.

NOTE ▶ ​The “ Continue from previous” button is selected. If a document has more 
than one list and you want each list to start at 1, select the “Start from” option and 
type 1 in its field.

Each paragraph now starts with a number. To create a tiered list, the paragraphs must 
be indented.

3	 Click the word “Firebox,” listed as paragraph number 2.

4	 In the Text inspector, click the Increase Indent button.

The paragraph is indented and labeled 1.1.

5	 Click the word “Cab,” now listed as paragraph 2. In the Text inspector, indent the 
paragraph.

The Cab paragraph is indented and labeled 1.2.

NOTE ▶ ​If you were to indent paragraph 1.2 again, it would be renamed 1.1.1.
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6	 Click the number 3 to select the entire bullet paragraph.

7	 Drag the number 3 upward. A blue horizontal line appears. Move the blue line above 
list item 1.

NOTE ▶ ​Bullets can be dragged left or right to change their indent levels.

The bulleted list updates the numbering using the new order. This function allows 
topics to be typed randomly and later structured for sequence and hierarchy.

8	 Choose File > Save to save a version of 2009_report.pages.

Presenting Data Using Charts

Charts help illustrate data. They can highlight trends or show the breakdown of a budget. 
Like Numbers, Pages can create charts; but there are some differences in how you use it 
to add and edit charts. Generally, Numbers has greater data-crunching flexibility. In this 
exercise, you will create a line chart in Pages to illustrate the cash flow for a fictitious res-
toration project.

1	 In the 2009_report.pages document, go to page 6 and find two tables: Cash Flow by 
Month and Annual Totals.
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The annual totals show a balance of $5536 so you have sufficient funds for the ficti-
tious restoration project. What is less clear is the monthly balance of funds.

Look at the Profit and 321 Budget lines at the bottom of the Cash Flow by Month 
table. In several of the months, you won’t have enough money to pay the restoration 
bill. Line charts are often used to display trends or patterns like this. Let’s make one.

2	 In the toolbar, click the Chart icon. In the dialog, select the 2D line chart.

A chart appears with placeholder data. You will replace this with data from a table.

3	 Move the chart if necessary so that it doesn’t obscure any tables.

You’ll resize the chart later.

NOTE ▶ ​You have other methods for creating charts in Numbers.

4	 In the Cash Flow by Month table, select rows 1, 7, and 8 by Command-clicking the 
reference headers for those rows.

5	 Choose Edit > Copy.
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6	 Select the line chart to display the Edit Chart Data button.

7	 Click the Edit Chart Data button to open a new table dialog.

You will paste the copied data into this table, but first you need to select fields in  
the new table.

8	 Select the first three rows of the Chart Data table by Command-clicking each  
row header.

9	 Choose Edit > Paste. The Chart Data dialog populates with the table data you copied.

You may want to resize the Chart Data window to see all the data.

The paste operation added extra rows. Let’s remove them now.
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10	 Command-click the header for each of the blank rows. Press Backspace to delete the 
blank rows.

You now have a 2D line chart created in Pages.

To edit the chart data, you click the Edit Chart Data button and change the figures. 
This method differs from Numbers in which you change data in the original table to 
automatically update any chart created from it.

11	 Select the chart, and drag the selection handles to change its width and height.

NOTE ▶ ​The selection handles are the small squares that appear in the corners and in 
the middle of three sides of the selected chart.

12	 Drag the chart into clear space on the page.

NOTE ▶ ​Other page elements move as you reposition the chart. This is caused by text 
wrap options, which are covered in Lesson 5.

The line chart now displays the difference between income and expenditure. In the 
next exercise, you will change the labeling to display selective information.
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Creating Chart Styles

You can choose from many types of charts. By default, placeholder data has generic labels. 
In the chart you created, the x-axis is now marked in months; the y-axis displays the cor-
rect figures, but has no dollar units. You will change that now.

In this set of exercises, you’ll change many of the format options for charts, learning  
techniques you can apply in Numbers and Keynote.

1	 In the Format inspector, click the Axis tab, and then click the Value (Y) tab.

2	 In the Value Labels section, change the format to Currency. Set Decimals to 0, and 
Currency to US Dollar ($). Select or deselect the Thousands Separator checkbox to 
suit yourself.

3	 In the Format inspector, click the Series tab. Change the Data Symbols to squares and 
set their Size to 11.

With five data symbols to choose from (and the ability to scale them), you can  
customize your charts.

Although this chart doesn’t call for them, feel free to experiment with Value Labels 
and Trendlines in the Series pane.
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4	 In the Format inspector, click the Axis tab, and then click the Category (X) tab.

5	 Change the Gridlines to dots.

6	 In the Format inspector, click the Chart tab.

7	 In Chart Options, select Title.

The legend and title overlap, so let’s move the legend.

8	 Click to deselect the table, if necessary, and then drag the legend beneath the chart.

9	 Double-click the title, and type Cash Flow.

Giving charts and tables specific titles helps identify what’s what.

 In the Chart Title tab in the inspector, you can set a different font style.

The chart now displays the key information required. As a finishing touch, let’s 
change the chart colors.

10	 With the chart selected, click the green data line.
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11	 In the Style tab of the inspector, click the color wheel for Stroke to open the Colors 
window.

12	 Click the eyedropper icon.

Your pointer changes to an eyedropper.

13	 Click the dark green of the Sophia Larkinson logo. The data symbols change color.

14	 In the Connection Line options, click the color wheel button. In the Colors window, 
resample the dark green of the logo.

The chart’s green now matches Sophia’s business signature color.

Pages, Numbers, and Keynote can make great-looking charts. There are lots of 
options to explore, so that you can display your data clearly and quickly.

Using Footnotes and Endnotes

Pages can add footnotes or endnotes, which appear at the bottom of a page or at the end 
of a document or section, depending on the options you set.

NOTE ▶ ​For research projects that require a bibliography, EndNote can be purchased. 
It is an application that enables you to search, organize, and share your findings. You 
can access EndNote within Pages as you write.



Using Footnotes and Endnotes    105

In this exercise, you’ll use Pages to add footnotes to the 2009_report.pages document.

NOTE ▶ ​You can’t use footnotes and endnotes in the same Pages document.

1	 Go to page 2 of the 2009_report. In the Solution subsection, click after the term 
“modern paints.”

2	 Choose Insert > Footnote, and type safe and tough.

A footnote is placed at the bottom of the page, numbered 1.

3	 Click at the end of the Background paragraph.

4	 Choose Insert > Footnote, and type TBA.

Because the second footnote insertion comes before the first footnote in the reading 
order it is labeled 1.

NOTE ▶ ​By default, footnotes and endnotes are numbered continuously throughout a 
document using Arabic numerals, but you can change this.

5	 Select the footnote, TBA.
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6	 In the Text inspector, set the type to Bold.

Only the selected footnote’s font style changes. When you want to change the format-
ting of every footnote in a document, perform the following steps.

7	 Choose Edit > Deselect All.

8	 Click a footnote.

All the footnotes show blue selection lines. Any change made to the font or typeface 
will now affect every footnote in the document.

9	 In the Text inspector, change the type size and style to 6pt italic.

All the footnotes change. Now you’ll change the footnotes to endnotes.

10	 In the Footnotes inspector, change the Type pop-up menu to Document Endnotes.

The footnotes that were on page 2 move to the end of the document.

NOTE ▶ ​Use the Footnotes inspector to change the numbering format and sequence. 
If a document is sectioned, you can choose to have endnotes appear at the end of each 
section, and the endnote numbering starts from 1 in each section.
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Checking a Document for Errors

Pages will help you stay error free by checking spelling and grammar as you write. You 
can also check a word’s definition with a couple of clicks.

1	 Choose Edit > Spelling and Grammar > Check Spelling While Typing.

2	 Go to page 3. In bullet number 5, the word “warrent” is misspelled, as indicated by a 
red dotted line.

3	 Click at the end of the word “warrent” to display some spelling suggestions.

4	 Click the × at the end of the spelling suggestions to close the suggestion bubble with-
out correcting the spelling.

5	 Control-click the misspelling of warrant.

The shortcut menu that appears offers spelling suggestions, and options to ignore a 
misspelled word or to learn its spelling.
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6	 Choose “warrant” to set the correct spelling.

7	 Control-click the word “warrant” and choose Look Up “warrant” from the  
shortcut menu.

A popover appears with dictionary, thesaurus, and Wikipedia entries.

8	 Click the word “Thesaurus” to open the dictionary application. It has extended defini-
tions and hyperlinks to help you further research the selected word.
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9	 Close the Dictionary window to return to Pages.

NOTE ▶ ​A green dotted line under a word or words indicates a possible grammar or 
punctuation error.

Although you are working with Pages, the spelling suggestions are generated by the 
operating system. The dictionary and autocorrect preferences can be set in Pages, but 
they affect all applications that use autocorrection.

10	 Choose Edit > Substitutions > Show Substitutions.

In the Substitutions window, you can set the following options:

Convert double hyphens (--) to dashes (—).

Convert straight quotes to curly quotes.

Auto-detect website addresses (URLs) and email addresses and turn them into links.

Select or deselect your preferred options.

11	 Click the Text Preferences button.

The System Preferences open in the Text pane of the Keyboard preferences. Any 
changes made here are applied systemwide.
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By default, Spelling is set to Automatic by Language. If you were writing for someone 
in England, you might change the language to British English so that, for example, 
any instances of the U.S. English spelling of “color” would be marked as misspelled, or 
autocorrected to “colour” as you type.

 Click the Add (+) button at the lower left of Text preferences to add a 
new “replace with” option. Imagine the time saved if an author who was writing a 
book about Pages, Numbers, and Keynote could replace a typed “pnk” with “Pages, 
Numbers, and Keynote” as a preference. So, every time he typed “pnk” the title of the 
book would automatically appear.

12	 Close System Preferences and return to Pages.

13	 Choose Edit > Spelling and Grammar > Check Correct Spelling Automatically. Make 
sure this default setting is selected.

14	 Type teh. Pages automatically changes this to “the.”

 If you actually want to spell a word as teh, or any other word that otherwise 
autocorrects, type the word, but don’t press the Spacebar. When the spelling sugges-
tion appears, click the × to reject the autocorrection.

NOTE ▶ ​Clicking the Replace All button sets substitution preferences across a whole 
document. Clicking the “Replace in Selection” button affects only a text selection. 
Closing the Substitution dialog without choosing one of these options does not affect 
existing text.
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Lesson Review

1.	 In Pages, how do you edit the data in a chart?

2.	 You have written a list in Pages, and selected Tiered Numbers in the inspector. 
Describe two ways to indent list items.

3.	 You have placed footnotes on the last page of a Pages document containing several 
chapters. The Footnote inspector has been set to Section Endnotes. What steps are 
required to place the endnotes at the end of each chapter?

4.	 A budget was created using a table in Pages. The currency format defaulted to U.S. 
Dollars. How do you change the currency to Chinese Yuan?

5.	 As you type, URL references are automatically being created. How do you turn off this 
function?

Answers

1.	 Select the chart and click the Edit Chart Data button.

2.	 Use the Increase Indent or Decrease Indent buttons in the Format inspector; or drag 
the button number left or right.

3.	 Start a new section for each chapter.

4.	 Select the cell ranges. Use the Format inspector’s cell options to change the currency.

5.	 Choose Edit > Substitutions > Show Substitutions. Deselect Smart Links.
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Symbols and Numbers
– (minus) key

for budget sheets, 201
decreasing text size, 47

– (remove) button, for tab stops, 84
(/) slash key, for keyboard  

shortcuts, 373
[ (left bracket) key, returning to 

previous build, 373–374
+ (plus) key/button

adding custom chart, 366
adding image styles, 351
adding new records, 496
adding shape styles, 357
adding text box formatting, 129
applying table style, 133, 220
for blank sheets, 195–196
for Data Format new items, 257
in defining character styles, 176
increasing text size, 47
for new Pages document, 490
for replace with option, 110
for tab stops, 83

= (equals) key/sign
adding functions with, 38
for budget sheets, 201
clearing cells, 223
opening Formula Editor, 242

=SUM formula, for budget tables, 
206–207

3D tab, pie chart icon in, 35

A
A4 paper size choice, in Doc Setup 

screen, 429–430
absolute cell referencing, 238–242
Accept All Changes option, for tracked 

changes, 142–143
Accommodations cells, placing logo 

over, 197
Accounting Style option, for budget 

sheets, 201–202

Action pop-up menu, Author Color 
choice in, 138

actions
creating custom animation with, 

332–334
drawing animation paths with, 

335–339
Emphasis, previewing, 331–332

Add a Column option, in sorting 
tables, 246

Add a Filter option, 249
Add a Rule button, for conditional 

highlighting, 229–232
Add Action button, Rotate action 

in, 333
Add an Effect option

choosing Move as, 335–337
choosing Wipe as, 327
in creating moods, 317
for Jiggle effect, 331–332
in Transitions inspector, 298

Add Audio button, in Document 
inspector, 323

Add Header Column After option, in 
formatting tables, 222

Add (+) key/button
adding custom chart, 366
adding image styles, 351
adding new records, 496
adding shape styles, 357
adding text box formatting, 129
applying table style, 133, 220
for blank sheets, 195, 196
in defining character styles, 176
increasing text size, 47
new items to Data Format, 257
for new Pages document, 490
for replace with option, 110
for tab stops, 83

Add Link, in designing  
presentations, 408

Add Row Above option, 32

Add Slide button, in building 
presentations, 290

Add to Template Chooser option
loading templates, 147
saving designs as templates, 

164–165
Add to Theme Chooser option, 303, 

366–367
Adjust Image window

Enhance button for, 43
Levels sliders in, 125

adjusting layouts, in Keynote, 44–47
Adobe Digital Editions ePub  

reader, 184
Advanced Image Fill, for Tint Color 

overlay, 309
Advanced Options popover, in making 

logotypes, 120
Align Objects option, 47
alignment guides

for business card artwork, 150
centering postcard shape, 158
positioning logos, 197

All Borders icon, in Cell inspector, 252
All Sheets radio button,  

for printing, 212
Allow Editing option, for collaborative 

work, 482
Allow Mission Control, Dashboard 

and others to use the screen  
checkbox, to access Application 
Switcher, 375

Allow objects on slide to layer with 
master checkbox

in Format inspector, 330
keeping logo on front layer, 360

Animate button, in adding transitions, 
298, 317

Animate inspector
Delay field in, 322
setting Rotate action in, 332–334
Start Transition option in, 321
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animation
copying and pasting, 327
creating custom, 332–334
customized themes and, 362
drawing paths with, 335–339

Appearance icon, in iBooks, 186–187
Apple apps, common features

adding comments, 39–41
adding photos, 41–43
adjusting layouts, 44–47
choosing themes, 14–16
customizing toolbars, 19–22
distributing work, 26–29
editing text, 16–18
illustrating data with charts, 34–38
opening, 13
overview of, 11–12
repeating image styles, 22–23
saving documents, 23–25
securing files, 49–50
swapping between apps, 13–14
trimming movie clips, 48–49
working with tables, 29–33

Apple Certified Pro status, 8
Apple curriculum

additional resources, 9
course structure, 4–6
downloading/installing lesson 

files, 7–8
learning methodology for, 4
system requirements for, 6–7
training/certification process, 8

Apple ID account setup, 422
Apple Photos, availability of, 41
Application Switcher, accessing/

opening, 375–376
Arabic numerals, for footnotes/

endnotes, 105
arguments

definition of, 243
in making price calculator, 256
quotation marks around, 244

Arrange inspector
changing Rotate Angle in, 154
customizing logos in, 355
Subtract button in, 172
Text Wrap pop-up menu in, 156

Arrange pane
changing page order, 122
Constrain Proportions option 

in, 58
in creating presentations, 287
for layer order, 197
moving logo to front layer in, 360
in Pages iOS documents, 441–442
setting logo Size and Position, 150

setting postcard Size/Width/
Height, 158

Arrangement tab, for external  
display, 417

arrow key, positioning artwork, 151
artwork, duplicating on single sheet, 

148–151
assessment tables

adding evaluation data formats, 
225–229

conditional highlighting for, 
229–233

formatting, 219–222
referencing data to, 222–225

attendance figures, slider data 
formatting for, 228–229

audio files
adding to iOS device, 460–465
adding to Pages, 181–182

audio icon function, 181
Audio inspector

dragging audio clips to, 323–324
for playing audio clips, 181

audio media button, 182
audio soundtracks, adding to 

presentations, 322–324
Author Color, in document  

review, 138
Author field, in document review, 136
Author Name, with tracking changes, 

443–444
autocorrect preferences, 109–110
Automatic by Language, for Spelling 

preference, 109–110
automatic data detection, with tables, 

88–93
automatic triggering, of transitions, 

320–322
Automatically Detect Lists checkbox, 

in General preferences, 32–33
Automatically option, in Animate 

inspector, 321
Automatically play upon open 

checkbox, for self-playing 
slideshows, 403

autosave, in Pages, 23
Axis inspector, for stacked bar  

charts, 264
Axis tab, for chart styles, 102–103

B
B key, for black screen, 373, 375
Background & Border Style, for  

charts, 269

Background Color pop-up, in 
formatting table styles, 132

Background section, of Format 
inspector, 309

Backward button
arranging layer order, 118
for photo placement, 123

Bar Shape, for stacked bar charts, 266
Bar Style options, 275
Basic actions, previewing, 332
Best for display option, in external 

display setup, 416–417
Blank Landscape template, for 

postcard design, 157–161
Blank template, in Numbers  

for iOS, 448
bleed area

in print preparation, 133–136
usual size of, 160

Border pop-up menu, for table  
styles, 132

Border section
changing Scale in, 351
increasing border size, 463

Borders & Rules settings
in making logotypes, 120
setting logo border lines, 150

brochure design
changing page order, 121–125
changing to page layout, 114–119
collaborative review of.  

see collaborative review
creating shape styles, 127–129
enhancing images, 125–127
formatting table styles, 129–133
making logotypes, 119–121
preparing for print, 133–136

budget planner, adding functions to, 
204–207

budget sheets, in Numbers, 199–204
Build In tab

in Animate inspector, 300
options in, 459

Build Order button
in creating custom animation, 

333–334
in drawing animation paths, 338

Build Out tab, controlling 
presentations, 326–328

builds
adding in Keynote for iOS, 

458–459
adding to presentations, 299–300
controlling presentations, 

325–328
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Bullets & Lists menu
creating/applying styles, 66
in creating tiered lists, 97
in updating paragraph style, 348

bullets, saving styles for, 65–66
business cards

creating from templates, 146–147
customizing layout, 148–152
steps for loading templates, 147

Buttons Only option, for interactive 
charts, 271

By Bullet option, setting build delivery 
to, 300

C
calculators, custom

absolute/relative cell referencing, 
238–242

concatenating cells for, 242–245
creating price calculator. see price 

calculators
filtering tables for, 246–250
overview of, 237–238
sorting tables for, 245–246

calendar icon, for setting date and 
time, 71

Calibre ePub reader, 184
Camera app, for iOS devices, 463–465
capital letters, functions displayed 

in, 243
Capitalization settings

lowercase flexibility in, 119
in new Title master slide, 359

carriage returns
adding vertical space, 359
creating empty space with, 174
video insertion points at, 

178–179
Cash Flow by Month table, for line 

chart, 99
Category (X) tab, for chart styles, 103
Category (Y) button, creating stacked 

bar charts, 264
Cell inspector

Border Styles menu in, 252
budget sheet options, 201–202
changing data format in, 92–93

cells
absolute/relative referencing of, 

238–242
for budget sheets, 200–203
checkbox/slider formatting for, 33
clearing, 223
concatenation of, 242–245

editing of, 32
listing functions in, 37
manual formatting of, 93
merging, 129–131

Change Master, in Slide Layout 
inspector, 302

Change Paper Size option, for Pages 
iOS documents, 429

Change Password button, 50
Change Theme button

in applying custom themes, 474
in Document inspector, 303

change tracking
for Pages iOS documents, 

443–446
reviewing, 139–143

Character Spacing option, in making 
logotypes, 120

character styles
applying, 63
creating, 175–177

Chart Data dialog, adding table data 
to, 100–101

Chart Depth, for stacked bar  
charts, 266

Chart icon, in toolbar, 35
Chart Title tab, for font styles, 103
charts

adding to themes, 361–362
custom colors for new styles in, 

362–366
interactive charts in, 270–272
mixed charts in, 266–268
opening CSV file for, 262
overview of, 34–38, 261
in Pages, 98–101
saving templates, 278–279
scatter charts in, 276–278
showing margin of error, 273–276
stacked bar charts in, 263–266
styles for, 102–104, 268–270

checkboxes, for assessment tables, 
225–226

Choose a Filtering Rule popover 
options, 248

Choose a Format option, for sharing 
documents, 433

Choose a Highlighting Rule  
options, 232

Choose a Template window
in creating new documents, 56
on iOS devices, 425

Clear option, removing slideshow 
recording, 402–403

Clear Override option, in editing 
Word document, 80–81

Clothes table, in Packing List  
sheet, 198

coaching tips
accessing, 20
in Numbers for iOS, 448
for Pages iOS documents, 426

collaborative review
adding comments in, 136–138
labeling user name in, 136
reviewing tracked changes, 

139–143
Color Fill option

for charts, 268–269
in cleaning up table design, 252
in making logotypes, 124
for postcard design, 160

Color Planes, in Keynote for iOS, 457
color swatches, in Text Options  

screen, 436
color wheel, in Text Options screen, 

437–438
colors

creating moods, 319
custom, creating chart styles 

with, 362–366
Colors window

changing text color in, 127–128
choosing colors in, 60–61
custom chart colors in, 363–366
Opacity data field in, 124
opening, 59
in styling charts, 104, 268–269
in updating paragraph style, 

345–346
columns

adding, 207
for budget sheets, 200–203
parallel lines icon for adding, 

36–37
selecting cells in, 30–31

comma-separated value (CSV)  
file, 262

Command-L, to lock elements, 160
Command-Option-L, to unlock 

elements, 160
Command-Option-P, to play 

slideshow, 319, 320, 322
Command-R, showing/hiding  

rulers, 158
Command-Shift-Z, redoing style 

updates, 310
commas, for separating arguments, 

253–256
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Comment icon, 40
comments

adding, 39–41, 446–447
in document review, 136–138

concatenation of cells, for customized 
calculators, 242–245

conditional highlighting, for 
interactive spreadsheets, 229–233

Connect icon, in customizing 
workspace, 288

Constrain Proportions option, in 
Arrange tab, 58

Contact Shadow option, for image 
styles, 22–23

Content Scale, for printing tables, 212
Continue from previous button 

option, for tiered lists, 97
Control-click

with anchor paths, 337
in skipping slides, 385

Convert to Footer Row option, for 
tables, 93

Convert to Header Column option, for 
tables, 222

Convert to Header Row option, for 
tables, 221

Copy Animation option, 327
Copy command, in customizing 

layout, 149
Copy Link button, for shared 

documents, 484
Copy Style button/icon

dragging to toolbar, 21, 288
with image styles, 23

copyright protection, of typeface, 350
Count option, in Formula icon, 38
COUNTIF function, for data in cells, 37
course structure, in Apple curriculum, 

4–6
cover page, preparing for ePub, 

171–173
Create a custom Pages template dialog, 

164–165
Create Document icon, in Pages 

document manager, 422–423
Create Spreadsheet option, in 

Numbers for iOS, 447
crop mark(s)

in business card templates, 152
in defining placeholder images, 

161–163
process, for postcard design, 

158–160
CSV (comma-separated value) file, 262
Currency format, in Value Labels 

section, 102

Current and Notes option, for Keynote 
Remote, 393

Custom Image button, updating 
paragraph style, 348

Custom Style, for conditional 
highlighting, 232

Customize Presenter Display option, 
379–380

Customize Toolbar option
in customizing workspace, 288
on shortcut menu, 20

customizing
calculators.  

see calculators, custom
colors, 362–366
page design, 57–61
themes. see themes, custom
timings for recording  

narration, 399
workspaces, 19–22, 288–289

Cut command
in customizing layout, 149
in formatting table styles, 

130–131

D
data

adding, with tables, 88–93
illustrating with charts. see charts
interactive formats for, 33
referencing to tables, 222–225

Data Format pop-up menu
for pricing calculators, 257
Slider in, 198

data organization
adding calculations, 204–207
assessing templates, 194–195
with budget sheets, 199–204
with multiple tables, 207–210
printing data, 210–212
working with sheets, 195–199

Data Set Name, for interactive  
charts, 271

Data Symbols, for chart styles, 102
date and time, calendar icon for, 71
dates

conditional highlighting for, 232
as filter option, 249–250

De-noise slider, for enhancing images, 
126

Define as Media Placeholder, 
deselection of, 163

Define as Placeholder Text, selection/
deselection of, 163–164

definitions, checking, 107–108

Delete Column option
in Column menu, 31
for formatting tables, 221

Delete Document option, in Pages for 
iCloud, 491

Delete Row option, for tables, 221
designs

brochure. see brochure design
saving as templates, 164–166

Desktop, as save location, 400
devices

checking Wi-Fi status on, 386
choosing templates on, 425–426
formatting Pages documents on. 

see documents, formatting
linking Keynote installations to, 

389–391
Lock Rotation on, 425
managing Pages documents on. 

see documents, managing
opening ePub documents on, 187
opening Keynote on, 387
opening photo library, 460
as remote control for slideshows, 

391–394
sync with/connect to Mac, 

187–188
using standard fonts for, 350
working with, 5–6

Dictionary window, in Pages, 108
Display preferences, for external 

display setup, 416
Dissolve effect

in adding transitions, 298
in creating moods, 318–320

Distribute Objects option, 47
distribution of work, in Pages, 26–29
Document Body checkbox,  

deselection of, 116
Document button, in choosing 

themes, 301
Document inspector

in applying custom themes, 474
arranging margins in, 116
choosing audio file in, 322–323
Self-Playing Presentation Type 

in, 403
setting features in, 21
setting header/footer in, 117
setting paper size in, 157

Document Setup options, in Pages for 
iOS, 428–431

documents
adding footnotes/endnotes to, 

104–106
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applying custom themes to, 
474–477

changing page order in, 72–74
checking for errors in, 107–110
collaborative work on, 482–485
converting to page layout, 

114–119
creating/applying styles in, 61–64
creating with template, 56–57
customizing page design in, 

57–61
exporting to ePub, 182–184
iOS, setting passwords for, 

466–467
keeping headers with paragraph 

in, 74–77
layout of multipage. see brochure 

design
making table of contents in, 

67–70
managing headers/footers in, 

70–72
moving from Mac to iCloud 

Drive, 478–480
opening on Mac, 472–473
Pages ’09, opening, 88
preparing for export to ePub.  

see ePubs
printing multipage, 134
saving, 23–25
saving styles for bullets/lists in, 

65–66
saving to Word/PDF formats, 

78–79
setting passwords for, 466–467
shared review of. see collaborative 

review
tabulating text in, 82–84
Word, opening/editing, 80–81

documents, formatting
adding comments, 446–447
applying Pull Quote style, 

434–435
modifying text wraps, 440–443
Style inspector text options, 

435–438
tracking changes, 443–446
undoing changes, 439

documents, managing
choosing template for, 425–426
Create Document icon for, 424
opening Pages, 422–423
renaming/sharing document, 

431–433
text editing for, 427–428

using Document Setup options, 
428–431

dollar signs, in Formula Editor, 241
Don’t Skip Slide option

in preparing presentations, 385
in presentations with links, 407

Double-Click To Edit text box  
options, 287

downloading lesson files, 7–8
Duplicate function

in creating self-playing 
slideshows, 402

in Reservations sheets, 196
Duplicate option, in saving 

documents, 25
duplicate pages, creating/modifying, 

134–135
Duplicate Selection, for postcard 

design, 159
Duration, for transitions, 298, 318, 

319, 458

E
Edit Chart Data button, on line  

chart, 100
Edit Data References button

in building scatter charts, 277
for interactive charts, 271–272

Edit Master Slide
in layering with master slides, 330
in selecting master slides, 343

Effects pane, in adding photos, 463
Emergency Contacts table, in 

Reservations sheet, 195–196
Emphasis actions, previewing, 

331–332
empty space

alternative method for, 175
carriage returns for, 174

Enable Presenter Display checkbox, 
for presentations, 415–416

EndNote application, 104
endnotes, adding, 104–106
Enhance button, in adding photos, 43
ePub reader, Adobe Digital  

Editions, 184
ePubs

adding audio to Pages, 181–182
adding movies to Pages, 178–180
creating character styles, 175–177
exporting to, 27–28, 182–184
preparing documents for, 

171–173
previewing in iBooks, 184–189
setting inline graphics to reflow, 

173–175

equals (=) key/sign
adding functions with, 38
for budget sheets, 201
clearing cells, 223
opening Formula Editor, 242

error bars
charts illustrating, 275–276
setting to Positive and  

Negative, 273
setting Use to Custom  

Values, 274
Excel workbooks, opening/editing, 

217–219
Export Your Document dialog

in distributing work, 26–28
exporting to ePub, 182–183
saving to Word/PDF formats, 

78–79
Export Your Presentation window, in 

QuickTime, 400, 406
Exposure setting, enhancing images 

with, 126
external display, for presentations, 

415–418
eyedropper icon

changing text color with, 128, 438
choosing color with, 60–61, 104

F
Fade Through Color option, in 

creating moods, 319
files

dragging, to create slides, 
310–313

reducing size of, 171, 414–415
securing, 49–50

Fill colors, for conditional 
highlighting, 230–231

filtering tables, for customized 
calculators, 246–250

Filters checkbox, 248–249
Find & Replace function, in creating 

character styles, 175–177
Finder

dragging audio clips from, 
323–324

dragging files to Keynote, 
311–313

removing files from iCloud, 499
Fit button, for table column/row  

size, 220
fonts

color options for, 436–438
copyright protection and, 350
increasing size of table, 251
iOS, 119
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in Pages for iOS documents, 
427–428

for paragraph styles, 310
for presenter notes, 383
problems with missing, 473
style options for, 435–436
updating paragraph style, 345, 346

footer rows, for adding columns, 93
footers

hiding on first page, 73
managing, 70–72
in page layout mode, 117
in Pages for iOS documents, 

430–431
footnotes, adding, 104–106
Footnotes inspector, changing 

numbering format/sequence in, 106
Format icon

in Pages toolbar, 16
Style tab in, 22–23

Format inspector
changing Heading attributes in, 

63–64
Edit Master Slide option in, 330
editing text in Pages, 16–18
Image tab in, 45
listing cell functions, 37
modifying charts, 36
Movie tab in, 48
in Numbers for iOS, 451
for slide backgrounds, 308–309
for Text tab options, 31
updating paragraph styles, 

345–347
formatting documents in iOS. see 

documents, formatting
Formula Editor

for budget tables, 205–206
cell references for, 229
in creating price calculators, 

253–256
in formatting tables, 93–94

Formula icon, Count option in, 38
Forward button, arranging layer  

order, 118
Freeze Header Rows option, for 

budget sheets, 203
Function Browser features, 253

G
Gather Windows button, for external 

display setup, 416
gear button, for file management 

commands, 490

General pane, Use template: Blank 
option in, 166

gesture options, in trackpads, 6–7
Go to My Documents option, editing 

Pages for iCloud, 489–490
Good option, in Image Quality  

menu, 26
Grade section, in filtering tables, 247
Grading Readiness tab

Table 1 in pop-up menu, 218
in upgraded spreadsheet, 217

Grading Readiness table
adding evaluation data formats, 

225–229
applying formatting to, 220
conditional highlighting for, 

229–233
referencing data to, 222–225

grammar, checking for errors in, 
107–110

graphics
instructions for modifying, 173
selecting shape for, 172
setting to reflow, 173–175

green bar, indicating loading slides, 377

H
H key, hiding presentation, 373, 375
Handoff function, moving documents, 

481–482
Handout Layout pop-up menu, in 

Keynote options, 411–412
handouts, Keynote

creating, 410–412
printing as PDF documents, 

412–413
headers

changing typeface of, 130
editing, in Pages for iOS docs, 431
hiding on first page, 73
keeping with following 

paragraph, 74–77
managing, 70–72
in Numbers iOS tables, 449–450
in page layout mode, 117

headings
applying styles to, 63–64
Lodging table, 196

Hide Comments option, 39
Highlight button, for Keynote  

Remote, 394
highlighting

conditional, 229–233
slides, while presenting, 394–396

Highlights slider, for enhancing 
images, 126

hyperlinks, disabling ligatures and, 171

I
iBooks

Appearance icon in, 186–187
reviewing ePub documents in, 

184–189
iCloud

applying custom themes from, 
474–477

documents copied to, 432
editing without iOS devices in, 

485–492
finding media in, 461
Handoff feature and, 481–482
moving documents from Mac to, 

478–480
opening iOS documents from, 

472–473
opening Pages in, 423
password security and, 466–467
removing tutorial files from, 

498–500
sharing Numbers documents, 195
signing in to, 422, 485
Use iCloud/Later options for, 388
using Numbers forms in, 

492–498
working collaboratively via, 

482–485
working with, 5–6

icons, layer placement of, 197
IF arguments, in creating price 

calculators, 253–255
illustrating data with charts, 34–38
Image Bullets menu, for custom 

themes, 348
Image Fill option, for slide 

backgrounds, 309
Image Mask control option, for 

printing, 134
image mask(s)

options, 122
reshaping, 134, 154

image placeholders. see media 
placeholders

Image Quality pop-up menu
choosing Best, 79
options in, 26

image styles
customizing/adding, 351
repeating, 22–23
thumbnail previews of, 352
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Image tab, in Format inspector, 45
images, enhancing, 125–127
imposition, in printing multipage 

documents, 133–136
Include slide numbers checkbox, for 

handouts, 411–412
Income Required table, 205–206, 

208–210
Increase Indent button, for tiered 

lists, 97
indenting paragraphs, 97–98
inline graphic options, 173–175
Input level meter, for recording 

narration, 397–398
Input volume slider, for recording 

narration, 397, 399
Insert from option, for finding  

media, 461
Inside Borders button, for table  

styles, 132
installing lesson files, 7–8
Instant Alpha button, in Format 

inspector, 45–46
interactive chart types, creating, 

270–272
Interactive Column chart type, 

270–272
interactive formats, for data entry, 33
interactive spreadsheets. see 

spreadsheets, interactive
Internal microphones, for recording 

narration, 396–397
International Digital Publishing 

Forum, 169
iOS devices. see devices
iOS documents. see documents
iPad devices

using Numbers forms on, 
492–498

working with, 5–6
iPhoto library

Photos tab for viewing, 42
returning to, 41

Itinerary sheet, creating spreadsheets 
in, 198–199

iTunes library, accessing soundtracks 
in, 322–323

iTunes syncing, 187

J
J key, to rewind slideshow, 373–374
Jiggle action, previewing, 331–332

K
K key, to pause/play slideshow, 

373–374
Keyboard preferences, in checking for 

errors, 109–110
keyboard shortcuts

applying to paragraph styles, 
77–78

list of, 373
to lock/unlock elements, 160
during slideshow presentations, 

374–376
Keynote

adding charts to themes in, 
361–362

adjusting layouts in, 44–47
automatic detection of data 

format in, 88–93
creating chart styles in, 102–104
creating chart styles with custom 

colors in, 362–366
creating new Title master slide in, 

356–360
creating title slides in, 180
developing presentations with, 5
Handoff feature in, 481–482
handouts, 410–412
media-rich presentations in. see 

media-rich presentations
modifying image placeholders in, 

350–353
opening on iOS device, 387–388
opening PowerPoint 

presentations in, 292–293
placing objects on master slides 

in, 353–356
presentations in. see presentations
recording self-playing 

presentations in, 396–399
rehearsal tools. see rehearsing/

delivering presentations
saving themes in, 366–368
securing files in, 49–50
selecting master slides in, 

342–344
standard fonts in, 350
swapping between Numbers/

Pages and, 13–14
themes in, 15–16
trimming movie clips in, 48–49
updating paragraph styles in, 

344–350
Keynote for iOS

adding builds in, 458–459

adding slides with media 
placeholders in, 456

adding transitions in, 456–458
adding video in, 463–465
applying custom themes in, 

472–477
choosing themes in, 455
opening Keynote, 454
opening photo library, 460
playing slideshows in, 460
replacing placeholder images in, 

461–463
selecting text for editing in, 

455–456
setting document passwords in, 

466–467
Keynote for OS X

applying custom themes in, 
474–477

opening iOS documents to, 
472–473

Keynote Remote
customizing view for, 392–393
highlighting functions in, 

394–396
opening, 388
for slideshow presentation, 394

L
L key, to fast forward slideshow, 

373–374
landscape orientation

designing brochures in, 115
with iOS devices, 425–426, 429
printing from Numbers in, 211

laser pointer, for presentations, 396
Last Opened document, deleting 

changes with, 24
Last Saved document, deleting 

changes with, 24
layers

arranging order of, 118
with master slide objects, 

328–330
Reservations sheet, 197

Layout Options, customizing, 392–393
Layout tab, Shrink text to fit option 

in, 347
layouts, adjusting, 44–47
Leader settings, 69
learning methodology, for Apple 

curriculum, 4
Legend option, for stacked bar charts, 

263–264
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Levels sliders, for enhancing  
images, 125

Ligatures, deselection of, 171
light table

reordering slides with, 313–316
for skipped slides, 385–386

Lighting Style, for stacked bar  
charts, 266

line charts, for illustrating data, 
98–101

line tool, creating postcard crop 
marks, 158–160

lines, toggling between straight/
curved, 173

Link to: Slide option, in designing 
presentations, 408

links
applying to two words, 409
designing presentations with, 

407–410
list(s)

referencing of, 222–225
saving styles for, 65–66
tiered, tables for creating, 96–98

Lock Rotation, on iOS devices, 425
Lodging table, in Reservations sheet, 

195–196
logos

customizing, 353–355
in new Title master slide, 360
placing on master slides, 356

logotype, creating in Pages, 119–121
Loop option, for soundtracks, 324
Loop slideshow checkbox, for self-

playing slideshows, 403

M
Mac computer(s)

applications, working with, 5–6
applying themes to iOS 

documents on, 474–477
moving documents to iCloud 

from, 478–481
opening iOS documents on, 

472–473
removing tutorial files from, 

498–500
using Numbers forms on, 

492–498
working collaboratively and, 

482–485
Mail PDF option, for printing in 

Pages, 29
Major gridlines, for stacked bar charts, 

264

Make Master Objects Selectable option, 
in customizing page design, 59

margin of error, charts illustrating, 
273–276

margins, in Pages for iOS  
documents, 429

Markup option, for change tracking, 
444–445

Markup Without Deletions option
for change tracking, 444–445
in reviewing tracked changes, 142

mask shapes, alternate, 171
master slides

image placeholders in, 350–353
layering objects with, 328–330
placing objects on, 353–356
selecting, 342–344

Match previous selection checkbox, in 
changing page order, 121–122

Maximum slider, for Packing List 
sheet, 198

Media Browser
accessing audio files via, 181
adding videos to documents 

with, 180
circular button opening, 42
in modifying image  

placeholders, 352
replacing placeholder images in, 

41, 163, 199
media placeholders

adding in Keynote for iOS, 456
changing to standard photos, 163
converting images to, 161–163
in iOS photo library, replacing, 

461–463
in Itinerary sheet, 198–199
modifying, 350–353

media-rich presentations. see also 
presentations

adding audio soundtrack to, 
322–324

controlling with builds, 325–328
creating custom animations for, 

332–334
creating moods for, 317–320
creating new slides for, 310–313
drawing animation paths for, 

335–337
layering with master slides in, 

328–330
light table features in, 317–320
previewing Emphasis action for, 

331–332
reordering slides for, 313–316
slide backgrounds for, 308–309

updating paragraph style for, 
309–310

Merge Cells function, in formatting 
table styles, 129–131

microphones, for recording narration, 
396–397

Microsoft Excel workbooks, 217–219
Microsoft Word format

opening/editing documents in, 
80–81

saving documents to, 78–79
minus (–) key

for budget sheets, 201
decreasing text size, 47

Mission Control, swapping between 
apps, 13–14

mixed charts
color for, 269
creating in Numbers, 266–268

modifying text wraps, 440–443
moods, transitions creating, 317–320
More Gestures tab options, 6–7
Move Object to Section Master option, 

in customizing page design, 59
move path, 335–337
Move with Text

options, for Pages iOS 
documents, 442–443

setting photo to, 174
movie clips, trimming, 48–49
Movie inspector, in triggering 

transitions, 321
Movie tab

options in, 465
video controls with, 48–49

movies
adding to master slides, 328–330
adding to Pages, 178–180
automatic transitions of, 320–322
creating from slideshows, 401
previewing in iBooks, 186

moving documents, 24–25
multiple tables, for organizing data, 

207–210
My Themes tab

for custom themes, 303–305, 
475–477

saving themes in, 367

N
name data, referencing to tables, 

222–225
Name field

renaming documents in, 24–25
with tracking changes, 443–444
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narrated presentations, recording, 
396–399

Navigator
adjusting layouts, 44–47
in creating presentations, 286
in trimming movie clips, 48–49

navigator view, adding slide transitions 
in, 297–299

New Form option, in Numbers for 
iOS, 495

No Border option
in Border pop-up menu, 132
in cleaning up table design, 252

Normal paragraph style, in editing 
Word documents, 80–81

number values, turning text into, 
253–256

Numbers
adding comments in, 39–41
adding photos in, 41–43
automatic detection of data 

format in, 88–93
creating chart styles in, 102–104
Handoff feature in, 481–482
illustrating data with charts in. 

see charts
making budget sheets in, 

199–204
making customized calculators 

in. see calculators, custom
making interactive spreadsheets 

in. see interactive spreadsheets
opening CSV file in, 262
opening Excel workbooks in, 

217–218
opening with specific  

template, 279
organizing/illustrating data with, 5. 

see also data organization
printing from, 210–212
securing files in, 49–50
swapping between Pages/Keynote 

and, 13–14
templates in. see templates, 

Numbers
working with sheets in, 195–199
working with tables in, 29–33

Numbers ’09 documents, opening/
upgrading, 216–217

Numbers for iOS
adding new tables/headers, 

449–450
adding virtual keyboards, 450
applying SUM formula, 452–454
choosing templates for, 448–449
configuring keyboards, 452

opening Numbers, 447
table formatting options, 451
working with forms, 492–498

Numbers - iCloud option, in moving 
spreadsheets, 493, 497

O
Object Placement options, in page 

layout mode, 122
objects, layering with master slides, 

328–330
Opacity slider

altering text/background, 125
for modifying logo, 354
in Style tab, 46

Open Display Preferences, for external 
display setup, 416

Open in Another App option, for 
Pages iOS documents, 432–433

opening Apple apps, 13
Optimize Movies for iOS, 182
Option-click, for adding anchor 

points, 337
Option-drag

for business card artwork, 151
in duplicating bar charts, 266

Order pop-up menu, in sequencing 
builds, 328

OS X Yosemite, Handoff feature in, 
481–482

Outline table name option, in making 
price calculators, 251

outline view
dragging text into slide  

sequence, 296
planning presentations in, 

294–297

P
Packing List sheet, tables in, 198
Page Attributes option, for Keynote 

handouts, 411
page design, customizing, 57–61
page layout mode

adding/deleting pages in, 
134–135

changing to, 114–119
page order in, 121–125

page margins, in Pages for iOS  
docs, 429

page numbers
adding to table of contents, 68
choosing format for, 71
formatting in Pages for iOS  

docs, 431

Roman numerals for, 74
page order

changing, 72–74
in page layout mode, 121–125

Page Orientation, 115, 211
Page thumbnails

in modifying template designs, 
56–57

for quick navigation, 19
reordering sections with, 72–74

Pages
adding audio to, 181–182
adding footnotes/endnotes in, 

104–106
adding video to, 178–180
automatic detection of data 

format in, 88–93
autosave in, 23
building custom templates in, 

157–161
checking for errors in, 107–110
creating business cards in. see 

business cards
creating chart styles in, 102–104
creating line charts in, 98–101
creating posters in, 153–156
designing brochures in.  

see brochure design
documents in iOS.  

see documents, managing
editing text in, 16–18
exporting documents to ePub. 

see ePubs
Handoff feature in, 481–482
opening, 13
printing from, 28–29
publishing with, 5
saving documents in, 23–25
securing files in, 49–50
sharing work in, 26–29
swapping between Numbers/

Keynote and, 13–14
templates in, 14–15
word processing in.  

see word processing
Pages ’09

exporting documents to, 27–28
opening, 88

Pages for iCloud, editing without iOS 
devices in, 485–492

Pages for iOS
formatting documents in. see 

documents, formatting
managing documents in. see 

documents, managing
moving documents in, 478–480
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Pages for OS X
applying custom styles in, 

480–481
deleting/saving documents in, 492

Pages - iCloud option, for moving 
documents, 479

paintbrush icon, for text formatting, 435
paper size

for Pages iOS documents, 
429–430

printer options for, 21–22
paragraph styles

applying keyboard shortcuts to, 
77–78

creating/applying, 61–64
in keeping headers with 

paragraphs, 74–77
opening/reordering menu for, 81
updating, 309–310, 344–350

parentheses, placing formulas in,  
243, 256

passcode, on iOS Keynote/Mac, 390
passwords

for exiting slideshows, 404–405
for interactive spreadsheets, 

233–234
for iOS documents, 466–467, 

472–473
removing/changing, 50
setting, 49–50
for shared documents, 483
testing, 467

Paste Animation option, 327
Paste command, in customizing 

layout, 149
Paste function, formatting table styles, 

130–131
Paste Style button/icon

dragging to toolbar, 21, 288
with image styles, 23

Paused switch, 142
PC computers, Pages editing in, 

485–492
PDF format

saving documents to, 78–79
saving handouts in, 412–413

Permissions pop-up menu, for 
collaborative work, 482

Personal category, in Numbers 
templates, 194

photos
adding, 41–43
downsizing of, 171
with iOS devices, 460–465
rotating, 154

Photos tab, for viewing iPhoto  
library, 42

Picture Frame image styles, selecting/
scaling, 154–155

pie chart icon, in 3D tab, 35
pie chart movie, 179–180
pie charts

adding to themes, 361
applying grading colors to, 

362–366
illustrating data with, 34–38

placeholder text
converting standard text box to, 

163–164
in creating new Title master slide, 

356–360
editing, on iOS device, 427–428
Pull Quote style in, 434–435

placeholders
in customizing layout, 149
hidden, 156
media. see media placeholders

Plain Text tab, for exporting 
documents, 27

Play button, for Keynote Remote, 391
plus (+) key/button

adding custom chart, 366
adding image styles, 351
adding new records, 496
adding shape styles, 357
adding text box formatting, 129
applying table style, 133, 220
for blank sheets, 195, 196
for Data Format new items, 257
in defining character styles, 176
increasing text size, 47
for new Pages document, 490
for replace with option, 110
for tab stops, 83

Point & Click tab, gesture options 
in, 6–7

Polynomial trendlines, 278
pop-up menus, for price calculators, 

257–258
portrait orientation

with iOS devices, 425–426
for tables in iOS, 453

postcard template design
building custom, 157–161
converting to placeholder images, 

161–163
creating, 157–161

Poster Frame slider
in adding movies to Pages, 179
trimming movie clips with, 48

posters, creating, 153–156

PowerPoint presentations, opening in 
Keynote, 292–293

preflight checks, for presentations, 
414–418

presentation tips, on iOS devices, 460
presentations

adding builds to, 299–300
adding slide transitions to, 

297–299
adding slides for, 289–291
applying themes to, 301–305
customizing workspace for, 

288–289
designing with links, 407–410
initial steps in creating, 284–287
opening PowerPoint, 292–293
playing on iOS devices, 460
recording narrated, 396–399
reducing file size for, 414–415
rehearsing/delivering.  

see rehearsing/delivering 
presentations

reordering/deleting slides for, 
293–294

self-playing.  
see self-playing slideshows

setting up second screen for, 
415–418

video and audio in.  
see media-rich presentations

working in outline view, 294–297
presenter display

customizing, 379–380
default layout of, 377
recording controls on, 398

presenter notes
adding/editing, 380–384
choosing options for, 377

Preserve Column option
cell referencing and, 241
in Formula Editor pop-up menu, 

208–209
Preserve Row option, in cell 

referencing, 240
presets, for printer settings, 28
Preview button

for Rotate action, 333
for viewing transition effects, 317

price calculators
adding pop-up menus, 257–258
adding totalizer, 258
cleaning up table design, 250–253
turning text into numbers, 

253–256
Print dialog, 28–29
Print Setup inspector, 211
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Print slide backgrounds checkbox, in 
making handouts, 411–412

printing
economically, 16
from Pages, 28–29
preparations, for brochure design, 

133–136
printer options for, 21–22

promotional materials
creating business cards.  

see business cards
creating posters, 153–156
defining placeholder images, 

161–163
defining placeholder text, 

163–164
postcard template design, 

157–161
saving designs as templates, 

164–166
Pull Quote paragraph style, 434–435

Q
question mark icon, to hide/show 

coaching tips, 426
QuickTime, exporting slideshows to, 

400–401, 405–406
quotation marks, for text arguments, 

244, 254–256

R
Rate Card table, 208–210
read-on problem, 299
Record button

on Audio tab, 398, 399
in Camera app, 464–465

red dot, as laser pointer, 396
Redo option, in Pages for iOS 

documents, 439
Reduce File Size option

for Keynote presentations, 
414–415

for shorter download time, 171
reference number, for cells, 30–31
referencing

cell, 238–242
data, 222–225

rehearsing/delivering presentations
adding/editing presenter notes, 

380–384
creating self-playing slideshows, 

401–405
designing presentations with 

links, 407–410

highlighting slides during, 
394–396

iOS devices as remote control for, 
391–394

making handouts for, 410–413
overview of, 371
preflight checks in, 414–418
recording narrated presentations, 

396–399
review keyboard shortcuts for, 

372–376
skipping slides in, 384–386
slideshow rehearsal, 376–380

Reject All Changes option, for tracked 
changes, 142–143

relative cell referencing, 238–242
Remaining option, in Timer  

options, 378
Remember this password in my 

keychain checkbox, 473, 483
Remember this password option, 467
remote control for slideshows, iOS 

devices as, 391–394
Remotes preferences, selecting Enable/

Link on, 390
Remove (–) button, for tab stops, 84
Remove Password button, 50
Rename option

in creating new Title master 
slide, 357

renaming sheets, 204–205
renaming documents, 24–25
renaming options, in Pages for iOS 

documents, 431
reordering slides, 293–294
Repeat Table Headers option, for 

printing, 212
repeating image styles, 22–23
Replace All button, for substitution 

preferences, 110
Replace in Selection button, for text 

selection, 110
Require password to exit slideshows 

checkbox, in Slideshow pane, 
404–405

Require password to open checkbox, 
in exporting documents, 27

Reservations tab, in Numbers, 
195–197

resources for training process, 9
Restore option, for documents, 24
Return key

adding bullet points, 295
navigating sheets, 201

Revert To menu, for Last Saved 
document, 24

review toolbar
Accept All Changes in, 143
in collaborative review, 136–138
Paused switch on, 142

Rotate options
for custom animation, 332–334
for custom logos, 355
drawing paths with, 337–339
for photos/text boxes/shapes, 154
previewing, 332

Row & Column Size option
Fit button for, 220
in formatting tables, 94

rows
for budget sheets, 200–203
parallel lines icon for adding 

more, 36
selecting cells in, 30–31

S
Same as Source Data option, for pie 

charts, 36
Saturation setting, for enhancing 

images, 126
Save as PDF option, for Keynote 

handouts, 412
Scale to Fill option, for slide 

backgrounds, 309
scatter charts

adding trendlines to, 278
building, 276–277

Scroll & Zoom tab, gesture options 
in, 6–7

Section inspector
formatting with Roman numerals 

in, 74
hiding headers/footers in, 73
Match previous selection 

checkbox in, 121
securing files, 49–50
security, password protection for, 

233–234
selection handles

changing chart width/height 
with, 101

increasing text box size with, 
358–359

scaling images with, 123, 355, 440
stretching tables with, 95

selection rectangle, for creating  
icon, 172

self-playing slideshows
creating, 401–405
exporting, 400–401, 405–406
recording narration on, 396–399
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Send Link button, for shared 
documents, 484

Series inspector, Error Bars in, 273
Set Password button

for iOS documents, 466
in securing files, 49–50

Set Up Remote popover, 389
Shadow pop-up menu

in creating shape styles, 128
in postcard design, 160

Shadows slider, for enhancing  
images, 126

shape styles
creating, 127–129
in creating new Title master slide, 

357–358
Share icon

for collaborative work, 482–485
for Pages iOS documents, 

432–433
Shared With Me icon, 490
Sharpness slider, for enhancing 

images, 126
Sheet menu, identifying tables with, 205
sheets

budget, 199–204
in Numbers, 195–199

Shift-click, in skipping slides, 384
Shift-drag, limitations of, 267
Shift-Return, for navigating sheets, 201
Shift-Tab, for navigating sheets, 201
Shift-Tab keys, removing  

indentation, 295
Show All Authors, reviewing tracked 

changes, 141–142
Show Bevels checkbox, for stacked bar 

charts, 266
Show Comments option, 40
Show in Function Browser option, 253
Show Invisibles option, 62–63, 115
Show Navigator button, for slide 

thumbnails, 383–384
Show Page Thumbnails option

in changing page order, 121
in customizing workspace, 19
in duplicating postcard  

design, 161
with templates, 56–57

Show Presenter Notes option
in adding/editing notes, 381
in creating presentations, 

288–289
Show Ruler

creating layout design, 116
customizing business card  

layout, 148

tabulating text, 82–84
Show Series as bar

in creating mixed charts, 267
Line Series button in, 269–270

Shrink text to fit option, 347
Skip Slide option

in creating self-playing 
slideshows, 402

in rehearsing slideshows, 385, 386
Slash (/) key, for keyboard  

shortcuts, 373
slide backgrounds, making in Keynote, 

308–309
Slide Layout area, in outlining 

presentations, 302
slide layout options, in creating 

presentations, 286, 289
slide navigator

adding/editing presenter notes in, 
380–384

adding video to master slide in, 
329–330

creating self-playing slideshows 
in, 402

deleting master slides in, 343–344
designing presentations with 

links in, 407–410
dragging media files to, 310–313
light table features in, 313–316
selecting master slides in, 

353–355
skipping slides in, 384–386
Title & Subtitle master slide  

in, 356
transition options in, 317–320
updating paragraph styles in, 

344–345
Slide Number checkbox, for slide 

backgrounds, 308
slider data format, for assessment 

tables, 228–229
sliders

adjusting thumbnail size, 314
on interactive charts, 271

slides
adding to presentations, 289–291
creating by dragging files, 

310–313
reordering, with light table, 

313–316
slideshows

adding builds to, 299–300
adding/editing presenter notes, 

380–384
adding transitions to, 297–299
Command-Option-P to play, 320

creating moods for, 317–320
creating self-playing, 401–405
exporting self-playing, 400–401, 

405–406
highlighting slides during, 

394–396
iOS devices as remote control for, 

391–394
keyboard shortcuts for, 372–376
playing on iOS device, 460
recording narrated, 396–399
rehearsing, 376–380
skipping slides in, 384–386

software applications, common 
features of. see Apple apps, 
common features

Sort & Filter button
in filtering tables, 247
in sorting tables, 245

Sort Ascending option
for alphabetical listing, 30
in concatenating cells, 244

Sort Descending option, in sorting 
tables, 245

sorting tables, for customized 
calculators, 245–246

Sound preferences, in selecting 
microphones, 396–397

Soundtrack section, dragging audio 
clips to, 324

Spacebar, to play through slides,  
318, 320

Spacing attributes, setting, 65
spelling, checking for errors in, 

107–110
spreadsheets

absolute/relative cell referencing 
in, 238–242

applying graphic design to, 
250–253

in Numbers for iOS, 447–454, 
492–498

spreadsheets, interactive
conditional highlighting in, 

229–233
evaluating data formats, 225–229
formatting tables in, 219–222
opening/editing Excel 

workbooks, 217–219
overview of, 215–216
password protection for, 233–234
referencing data, 222–225

stacked bar charts, 263–266
Standard themes, 15
star rating data format, for assessment 

tables, 227–228
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Start movie on click checkbox
deselection of, 320
preventing automatic playing, 49

Start on Tap option, in Movie tab, 465
Start Transition option

in Animate inspector, 321
using Delay field in, 322

Stay on Page, for cover page text/
photos, 172

stepper data formatting, 228
Stroke button, opening Colors 

window, 104
Style inspector

Picture Frame image style in, 154
scaling shape style in, 155
text options in, 435–438

Style options
in adding photos, 462–463
in creating presentations, 287
in Keynote for iOS, 461–463
in Pages for iCloud, 488

style sheets
applied to text boxes, 127–129
to create table of contents, 67–70
customizing page design with, 61
duplicating format, 18
paragraph styles in, 62–64
to save styles for bullets/lists, 

65–66
Style tab

Bullets & Lists menu in, 348–349
choosing title text color in, 345
Opacity slider in, 46

style tagging, 62
styles

chart, 102–104, 268–270
for tables, 129–133

Substitutions window options, 109
SUM formula, in Numbers for iOS 

tables, 452–454
swapping between open apps, 13–14
System Preferences, for identifying 

network, 386

T
Tab key

for further indentation, 295
navigating sheets, 201

tab stops, for reformatting figures, 
82–84

Table Font Size button, increasing font 
size, 251

Table Name, deselection of, 196, 205
table of contents

creating, 67–70

ePub document, reviewing, 185
labeling in Roman numerals, 74
Pages criteria for, 73

table styles
creating/applying new, 129–133
creating custom, 362–366

Table Styles, adding formatting to, 
219–222

tables
adding data with, 88–93
cleaning up design for, 250–253
creating list structures with, 

96–98
filtering, 246–250
formatting, 93–96
grading readiness, formatting, 

219–222
in Numbers, 29–33
in Numbers for iOS.  

see Numbers for iOS
Reservations sheet, 195–197
sorting, 245–246
working with multiple, 207–210

tagging documents
in creating presentations, 287
function of, 25
in Pages, 24–25

Take Photo or Video option, in 
opening Camera app, 464

Temperature slider, for enhancing 
images, 126

Template Chooser
Blank template in, 200
categories in Numbers, 194
deleting templates in, 166
saving designs as templates in, 

164–166
templates

choosing, on iOS devices, 
425–426

creating business cards from, 
146–147

creating documents from, 56–57
creating posters from, 153–156
deletion of, 166
in Keynote (themes), 15–16
in Numbers. see templates, 

Numbers
for Numbers spreadsheets, 

447–448
in Pages, 14–15
saving, 278–279
saving designs as, 164–166
steps in loading, 147

templates, Numbers
adding calculations with, 

204–207
assessing, 194–195
budget sheets in, 199–204
opening, 15
printing data from, 210–212
working with multiple tables in, 

207–210
working with sheets in, 195–199

text
changing type attributes, 68, 69
cutting and pasting, 130–131
editing, on iOS device, 427–428
formatting for logos, 119–121
formatting in iOS. see documents, 

formatting
highlighting, 137–138
increasing/decreasing size of, 47
tabulating, 82–84
turning into number values, 

253–256
text anchor points

controlling text/image flow, 174
determining audio control 

position, 181
in text wraps, 442–443

text boxes
converting to placeholder text, 

163–164
formatting pull quotes in, 434
increasing size of, 358–359
repositioning/shaping, 156

Text Inset, in creating shape styles, 127
Text inspector

Advanced Options popover in, 120
editing Word documents with, 

80–81
setting attributes in, 68–69
setting Tabs options in, 83–84
in updating paragraph style, 

347–349
text is not rule option, in filtering 

tables, 248
text options

in creating presentations, 287
in Pages iOS documents, 436–438

Text Preferences button, in checking 
for errors, 109

Text tab, in Format inspector, 31
text wraps

modifying, 440–443
None option for, 156

Theme Chooser
applying custom themes in, 

303–305, 474–477
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in Keynote for iOS, 455
opening, 284
in selecting master slides, 

342–344
themes

adding charts to, 361–362
applying to presentations, 

301–303
choosing, 14–15
Keynote, 15–16

themes, custom
adding charts for, 361–362
applying to iOS documents, 

474–477
chart styles with custom colors 

for, 362–366
modifying image placeholders 

for, 350–353
new Title master slide for, 

356–360
placing objects on master slides 

for, 353–356
for presentations, 303–305
saving, 366–368
selecting master slides for, 

342–344
updating paragraph styles, 

344–350
Thousands Separator checkbox, in 

creating chart styles, 102
3D Scene area, adjusting parameters 

in, 266
3D Stacked Bar option, in Chart 

inspector, 265
thumbnails

adding in Keynote for iOS, 456
in editing presenter notes, 

383–384
image style previews in, 352
in preparing for print, 134–135
sliders, 314
for Title master slide, 360

Timer options, 377–378
Times Tables tab, in cell referencing, 

239–242
Tint Color overlay, for slide 

backgrounds, 309
Tint slider

enhancing images with, 126
for quick fix, 127

Tips icon
coaching tips, 20
for help tags, 19

Title & Subtitle master slides, 
duplicating/renaming, 356–360

title change, in tracking changes, 
445–446

Title option, for stacked bar charts, 
263–264

Title paragraph style, updating, 
309–310

toolbar
accessing transitions/builds  

via, 459
Chart icon in, 35
default, customizing, 19–22
Shape icon in, 157, 158

Tools
in Pages for iCloud, 488–489
Set Password option in, 466

totalizer, adding to price calculator, 258
tracking changes

for Pages iOS documents, 
443–446

reviewing, 139–143
trackpads, gesture options in, 6–7
training and certification process, 8
transitions

adding effects to, 457–458
adding in Keynote for iOS, 

456–458
adding to presentations, 297–299
automatic triggering of, 320–322
creating moods with, 317–320

transparency, creating, 45–46
Transportation table, in Reservations 

sheet, 195–196
trash icon

for deleting files, 497–498
in filtering tables, 248–249

Travel Party table, in Reservations 
sheet, 195–196

Travel Planner category
opening, 194–195
working with tabs in, 195–199

trendlines, adding to scatter charts, 278
triggering transitions, 320–322
trim marks. see crop mark(s)
Trim slider

editing audio clips, 182
editing movie clips, 48–49, 321

2D mixed charts
color for, 269
creating, 266–268

typeface, copyright protection of, 350
Typewriter build, for presentations, 300

U
Underline Text button, 409
Undo button, for highlighting  

marks, 395
undoing changes, in Pages for iOS 

docs, 439
US Letter paper size, for Pages 

documents, 429–430
USB microphones, for recording 

narration, 396–397
Use ambient noise reduction 

checkbox, 397
Use iCloud option, in opening  

Pages, 423

V
Value Data Format pop-up, for pie 

charts, 36
Value Labels

Currency format in, 102
for stacked bar charts, 265

Value (X) button, for stacked bar 
charts, 264

Value (Y) tab, for chart styles, 102
Video button, in Camera  

application, 464
video files

adding to iOS device, 463–465
adding to Pages, 178–180
previewing in iBooks, 186

View Options pop-up menu, for 
change tracking, 141–142

View setting, for change tracking, 
444–445

View Share Settings option, for 
collaborative work, 482

virtual keyboard
configuring, 452
in Numbers for iOS, 450

visual feedback, conditional 
highlighting for, 229–233

Volume slider, for videos, 180

W
W key, for white screen, 373, 375
warning dialog, in opening Excel 

workbooks, 218
Wedges tab, for pie charts, 36
Welcome screen

Keynote, 387, 454
Keynote Remote popover, 389
Numbers, 447
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Pages, 423
Pages for iCloud, 486

Where pop-up menu, in moving 
documents, 24–25

Wide themes, 15
Windows PC computers, editing in 

Pages on, 485–492
Wipe option, with builds, 327
Word format

opening/editing documents in, 
80–81

saving documents to, 78–79
word processing

changing page order, 72–74

creating/applying styles, 61–64
creating new documents, 56–57
customizing page design, 57–61
keeping headers with paragraph, 

74–77
making table of contents, 67–70
managing headers/footers, 70–72
opening/editing Word 

documents, 80–81
saving styles for bullets/lists, 

65–66
saving to Word and PDF formats, 

78–79
tabulating text, 82–84

Word tab, in exporting documents, 27
workspaces, customizing, 288–289
Wrap options, in Pages for iOS 

documents, 441–442

Z
Zoom level, for mixed charts, 266
Zoom menu, for custom page design, 

60, 61
zoom option

for budget sheets, 200, 203
with photos, 42–43
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